
   
 
 
 

   
 
 
  

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                                                 solano 
                                                                                             with                       arm and Polygonia 

 
 
 

USER’S GUIDE 
 

 

baces 
 





  

KREON Technologies | User’s Manual SOLANO - 3 - 

Summary 
1 INTRODUCTION................................................................................................. 5 

1.1 DESCRIPTION OF THE SYSTEM............................................................................................... 5 
1.2 REQUIRED ENVIRONMENT ..................................................................................................... 5 
1.3 SENSOR USAGE PRECAUTIONS .............................................................................................. 5 

1.3.1 Security of the user regarding the laser................................................................ 5 
1.3.2 Transportation, storage and handling precautions ............................................... 6 
1.3.3 Maintenance ......................................................................................................... 6 

1.4 THE SOLANO SENSOR........................................................................................................... 6 
1.4.1 Technical characteristics of the Solano sensor .................................................... 6 
1.4.2 Presentation of the Solano sensor ....................................................................... 6 

2 INSTALLATION OF THE SYSTEM..................................................................... 7 

2.1 INTRODUCTION..................................................................................................................... 7 
2.2 SOFTWARE CONFIGURATION ................................................................................................. 7 

2.2.1 Configuration of the Ethernet card........................................................................ 7 
2.2.2 Software installation or update ............................................................................. 7 
2.2.3 Installation of the protection key ........................................................................... 7 

2.3 HARWARE ASSEMBLY ........................................................................................................... 8 
2.3.1 Mounting the sensor on the arm........................................................................... 8 
2.3.2 Mounting the touchprobe ...................................................................................... 8 

2.4 SYSTEM CONNECTION........................................................................................................... 8 
2.4.1 Cables and connectors ......................................................................................... 8 

2.5 SWITCHING THE SENSOR ON ................................................................................................. 8 

3 USING THE SYSTEM ......................................................................................... 9 

3.1 HARDWARE SELECTION......................................................................................................... 9 
3.1.1 Selection of the sensor’s calibration ..................................................................... 9 
3.1.2 Adding a new sensor calibration file ..................................................................... 9 
3.1.3 Arm selection ........................................................................................................ 9 
3.1.4 Arm properties ...................................................................................................... 9 

3.1.4.1 Driver installation .................................................................................................. 9 
3.1.4.2 Arm calibration file modification.......................................................................... 9 
3.1.4.3 Arm properties configuration............................................................................. 10 

3.2 VIDEO SETTINGS CONFIGURATION ....................................................................................... 10 
3.2.1 Function of each parameter................................................................................ 10 

3.3 GETTING READY TO SCAN ................................................................................................... 10 

4 THE “POSITIONING” PROCEDURE ................................................................ 12 

4.1.1 Description of the Positioning window................................................................ 12 
4.2 DATA ACQUISITION FOR POSITIONING................................................................................... 12 
4.3 COMPUTATION OF THE POSITIONING.................................................................................... 13 

4.3.1 Launching the computation................................................................................. 13 
4.3.2 Analysis of the results......................................................................................... 13 

4.4 SAVING THE RESULT OF THE POSITIONING ........................................................................... 13 

5 SCANNING IN POLYGONIA............................................................................. 14 

5.1 ADDING A DIGITIZATION....................................................................................................... 14 
5.2 DIGITIZATION...................................................................................................................... 15 



  

- 4 - KREON Technologies | User’s Manual SOLANO 

6 HARD-PROBING IN POLYGONIA.................................................................... 16 

6.1 ADDING A TOUCH-PROBE .................................................................................................... 16 
6.2 TOUCH-PROBE CALIBRATION ............................................................................................... 16 

6.2.1 Touch-probe calibration by sphere ..................................................................... 16 
6.2.2 Touch-probe calibration by hole ......................................................................... 16 

6.3 MEASUREMENTS WITH A TOUCH-PROBE............................................................................... 17 
6.3.1 Hard-probing geometric items ............................................................................ 17 
6.3.2 “3/2/1” Alignment ................................................................................................ 17 

7 POLYGONIA’S 3D VIEW HANDLING............................................................... 18 

7.1 MAIN AREAS OF THE INTERFACE .......................................................................................... 18 
7.2 HANDLING THE 3D VIEW ..................................................................................................... 18 
7.3 POINT CLOUD SELECTION.................................................................................................... 18 

7.3.1 Selection by area ................................................................................................ 18 
7.3.2 Selection by item ................................................................................................ 18 

8 OPTIONS COMMON TO ALL ITEMS ............................................................... 19 

9 FILE IMPORT/EXPORT .................................................................................... 20 

9.1 FILE EXPORT ...................................................................................................................... 20 
9.2 FILE IMPORT....................................................................................................................... 20 



  

KREON Technologies | User’s Manual SOLANO - 5 - 

1 INTRODUCTION 

1.1 DESCRIPTION OF THE SYSTEM 
The Kreon® scanning system is composed of the following items: 

- a Kreon Solano sensor; 

- an interconnection set of cables; 

- the Kreon® program: Polygonia (possibly coming with by optional plug-ins); 

- a protection key; 

- a datum sphere; 

- a travel case. 

1.2 REQUIRED ENVIRONMENT 
The minimum software environment required to use the Kreon® system is decribed below: 

- Intel Pentium II processor or equivalent, with a minimum frequency of 300 MHz; 

- Updated Windows 2000, XP or Vista operating system; 

- 10Mbits/s Ethernet network card correctly configured and dedicated to the Kreon® system; 

- 512 MB of RAM; 

- 1 GB of free disk space; 

- SVGA color monitor set to a resolution of at least 800x600; 

- Mouse or any other pointing device; 

- CD-ROM drive; 

- USB port to plug the protection key; 

- USB port for the measurement arm. 

 
The recommended configuration is: 

- Dual core Intel or AMD processor with a frequency of at least 1 GHz; 

- Updated Windows XP operating system; 

- 10Mbits/s Ethernet network card correctly configured and dedicated to the Kreon® system; 

- 2 GB of RAM; 

- 10 GB of free disk space; 

- High-resolution color monitor set to a resolution close to 1280x1024; 

- Mouse or any other pointing device; 

- CD-ROM drive; 

- USB port to plug the protection key; 

- USB port for the measurement arm. 

1.3 SENSOR USAGE PRECAUTIONS 

1.3.1 SECURITY OF THE USER REGARDING THE LASER 

The laser of the Solano sensor conforms to “class 2M” of norm EN60825-1 revision 2001-11 of 
January 1st 2004. The laser emission is harmless to the skin; however, it might hurt the eyes if 
exposed directly and for too long at a short distance. 

   Avoid looking towards the laser source, directly or by a reflecting surface. 

   Do not interpose magnifying optics in the laser field. 
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1.3.2 TRANSPORTATION, STORAGE AND HANDLING PRECAUTIONS 

The Kreon® system must travel in its case, which should be protected appropriately. 
The system must be stored in a dry and clean place with an ambient temperature between 0°C and 
70°C (32°F and 158°F).  

1.3.3 MAINTENANCE 

No maintenance is possible at the user level. Any system that would present a defect must be 
returned for repair to Kreon Technologies or one of the agreed distributors. 
None of the system components should be opened by the user. 

Warning : Breaking any of the rules and precautions listed in section 1.3 would void the warranty. 

1.4 THE SOLANO SENSOR 

1.4.1 TECHNICAL CHARACTERISTICS OF THE SOLANO SENSOR 

Characteristics  Values 

Sensor SOLANO SL100 

Laser diode Class 2M 

Wave length 635 nm 

Laser line length 100 mm 

Field of view 110 mm 

Number of points/second up to 40 000 

Weight 400 g 

Usage temperature 0°C to 50°C (32°F to 122°F) 

1.4.2 PRESENTATION OF THE SOLANO SENSOR 

 

# Function / Description 
1 Camera 
2 Working distance indicator 
3 Laser source 
4 Touchprobe support 
5 Sensor cable connector 
6 Attachment  

   Refer to section 1.3.1 regarding the precautions with the laser source (3). 

   Do not connect/disconnect the cable (5) when the sensor is on. 
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2 INSTALLATION OF THE SYSTEM 

2.1 INTRODUCTION 
Polygonia has an installation program that copies all the required files into the computer and 
configures it with the default parameters. 
If you do not have yet the calibration files for the scanner and the arm (supplied on a disk, a USB key 
of via Internet), the installation can be completed later. 

2.2 SOFTWARE CONFIGURATION 
   You must have administrator rights to configure the following parameters and install the software. 

2.2.1 CONFIGURATION OF THE ETHERNET CARD 

   The instructions of this paragraph must be followed thoroughly to ensure good communication 
between the PC and the sensor. 

� Set the IP address to 192.168.244.X* (*X can take any value between 1 and 254 but 43) and 
255.255.255.0 for the mask in the propeties dialog of the TCP/IP Internet Protocol of the 
Ethernet card. 

� In the « Advanced… » section of the properties dialog, remove any other IP address assigned 
to the Ethernet card. 

� Under Windows 7, the Public Network Firewall must be turned off. 
� From the Windows Device Manager, open the advanced properties of the network card and 

set its speed to “10Mbps Full Duplex”. The term may vary slightly depending on the network 
card models (for example “10Mbits/s Integral”). Take the closest option. Note: if 
communication problems persist, it might be necessary, with some Gigabit network adapters, 
to increase the value of parameter “Jumbo Frame” (or similar name). 

2.2.2 SOFTWARE INSTALLATION OR UPDATE 

� Insert the installation disk of Polygonia in the CD-ROM drive. If the installation does not start 
automatically after a few seconds, then execute Setup.exe manually from the CD-ROM. 

� Select the prefered language for the installation program and validate by “OK”. 
� Click “Next” when the window of the installation assistant appears. 
� Click “I agree” to accept the terms of license. 
� Choose the destination path of the software installation, if you do not want to use the default 

one, located in a subfolder of “Program Files”. 
� Click “Next” then “Install”. 
� At the end of Polygonia’s installation, you should accept to install the driver of the protection 

key and the Microsoft VS2005 redistributable files. 
� In the dialog box of the Aladdin driver for HASP SRM keys, select your prefered language 

then validate by “OK”. Click “Next” twice then “Finish” in the end. 
� When the window asking for the copy of the calibration file shows up, click “OK” and the 

« C:\Documents and Settings\All Users\Application Data\Kreon Technologies\Calibration » 
folder will open. Copy the SL100_XXX.cal file there (it should be supplied in the 
« Calibration » directory of the installation CD-ROM). 

� Click “Close” to end the installation. 

2.2.3 INSTALLATION OF THE PROTECTION KEY 

Plug the protection key into an available USB port. The key must always be present while you use the 
Kreon® system. 
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2.3 HARWARE ASSEMBLY 

2.3.1 MOUNTING THE SENSOR ON THE ARM 

� Fit the attachment of the sensor at the tip of the 7th axis 
of the arm. 

� Firmly screw the 3 small screws with the provided Hex 
key. 

 
 
� For 6-axis arms, first screw the provided interface at 

the tip of the arm (see opposite illustration). Then the 
assembly is the same as for the 7-axis configuration. 

 

2.3.2 MOUNTING THE TOUCHPROBE 

   This step is only necessary if you want to a touchprobe in 
addition to the scanner. 

 
 
� Screw the touchprobe on the sensor as shown on the 

opposite picture. 

     

2.4 SYSTEM CONNECTION 
   The connection/deconnection of the cables must be done while the hardware is off. 

2.4.1 CABLES AND CONNECTORS 

The connection kit of the solano is made of only one “Y” cable. 

� The main end is a SUB D 9 connected to 
the arm. 

From the SUB D 9 connector start: 

� One Ethernet (RJ45) cable linked to the PC 
on the previously configured Ethernet port; 

� One sensor cable connected to the Solano. 

 

   Do not turn the connector to unplug it from the sensor. 
 
� The arm is linked to the computer by its USB cable. 

2.5 SWITCHING THE SENSOR ON 
   The sensor must be linked to the arm. 

Le sensor takes its power from the arm. 
� Plug the power supply of the arm 
� Switch on the arm. 
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3 USING THE SYSTEM 

3.1 HARDWARE SELECTION 

3.1.1 SELECTION OF THE SENSOR’S CALIBRATION 

Each sensor has its own serial number and calibration file. 
� Click on menu “Setup > Select Calibration…” to display the list of available calibrations. 
� Select the calibration file corresponding to your sensor (.CAL extension). 
� Click OK to validate your choice. 
� If the calibration file of your sensor is not in the list, add it as described below. 

3.1.2 ADDING A NEW SENSOR CALIBRATION FILE 

� Copy the calibration file (SL100_XXX.cal) from the CD-ROM. 
� Paste the file into the following directory (or its equivalent in your Windows version): 
« C:\Documents and Settings\All Users\Application Data\Kreon Technologies\Calibration ». 

3.1.3 ARM SELECTION 

� Click on menu “Setup > Select Machine… » to display the available machines. 
� Select the machine parameters file (e.g. “Baces3D.par”). 
� Click OK to validate your choice. 

3.1.4 ARM PROPERTIES 

3.1.4.1 DRIVER INSTALLATION 
In order to use a Baces3D arm with the sensor, it is necessary to install the driver of the arm, first. The 
following procedure describes the Baces3D driver installation process: 
� If the arm driver do not have been installed during the installation of Polygonia or a plug-in, 

launch “Baces3D Install*.exe” from the installation CD-ROM of BacesWIZARD; 
� Choose your prefered language (English or Italian) for the installation program; 
� Validate the default destination directory; 
� Select the options (calibration file, documentation); 
� Clicking “Install” then “Finish” to end the installation procedure. 

3.1.4.2 ARM CALIBRATION FILE MODIFICATION 
The arm is provided with its calibration file (.TAB extension). By default, the file only contains “Factory” 
settings. It might then be necessary to upgrade it by adding a couple of profiles dedicated to the 
scanner: one for each 6-axis and 7-axis configuration. 

   The arm must be switched on, in the 6/7-axis configuration you are going to add, and the 
“BacesWIZARD” program must be installed (done the driver installation) and running. 

� Select menu “TAB > Change” to select the calibration file to modify then validate with “Open”; 
� Check that “Mark” is selected then click “Connect” and reset the axes of the arm; 
� Select menu “Tools > Probes management”; 
� Click “Add” to add a new arm calibration profile; 
� Choose “Scanner (ECU)”; 
� Name the new calibration profile (e.g.: “Scanner 7 axes”); 
� Enter any value in the “Probe diameter” cell (e.g.: “4”); 
� Check the “Reset Memory” box to activate the memorization of the axes initialization while the 

arm is on, in order to avoid reinitializing the axes each time the arm is used; 
� If the profile concerns the “7-axis” configuration of the arm, then check “Rotating probe”. 
� Click “Save” to validate the parameters; 
� Restart from the “Add” step if you want to create another profile with or without “Rotating 

Probe”. 
� Click “Apply” to take the new calibration into account then exit BacesWIZARD. 
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3.1.4.3 ARM PROPERTIES CONFIGURATION 
On the very first utilization of the arm after installation, the arm properties window will show up to let 
you indicate the calibration file of the arm. It is possible to show this dialog later via the menu item 
“Setup > Arm Properties…”. 
 

 

� Select the communication port (for Serial arms) 
or “USB” (for USB arms) in the drop-down list. 

 
� Define the path to the arm calibration file (see 

section 3.1.4.2). 

3.2  VIDEO SETTINGS CONFIGURATION 
   The configuration of the video settings can be done from Polygonia or any plug-in, after every 

thing is installed, configured and switched on. 

The Kreon® sensors can digitize surfaces of different textures and colors. In order to adapt to the 
various optical properties of the materials, the video settings window offers three parameters to control 
the sensor. It is very important to adjust these paramaters before beginning a digitization to achieve 
the best results. 
 
Click the “Video Settings” button , or select menu item 
“Digitization > Video Settings”. 
 
 
 
 
 
 
 
This value is the number of critical points. These are 
points rejected by the sensor because of their  
overexposure or their uncertainty due to the background 
noise of the image. It is recommended to have it as close 
to zero as possible. 

 

3.2.1 FUNCTION OF EACH PARAMETER 

• The integration time: 
The integration ranges from 1/60th to 1/8000th of a second. The darker the material the longer the 
needed integration time. This is the most important of the three parameters. 
 
• The LUT (Look-Up Table): 
The LUT level ranges from 0 to 255 and determines the threshold of intensity from which the pixels of 
the camera are kept to compute the points of the laser line. This prevents digitizing noise that one may 
encounter by setting a LUT threshold too low; however a too high level is not recommended, either. 
The best option is to set the minimum level without noise, plus a small tolerance (e.g. 5 units). 
 
• The laser power: 
Most of the time set to its maximum, the laser power ranges from 25% to 100%. Level “Off” sets the 
laser in Standby mode. 

3.3 GETTING READY TO SCAN 
Polygonia’s “Service” menu offers functions to calibrate the sensor (the procedure is called 
“positioning”) and the touchprobe. These functions are also available in the plug-ins (please refer to 
each plug-in’s documentation to know how to use them). 
These calibration procedures must be performed at least once after mounting the system, prior to 
digitization. 



  

KREON Technologies | User’s Manual SOLANO - 11 - 

• Sensor positioning: 
The “positioning” computes the orientation of the sensor on the arm. 
 
• Touchprobe calibration (facultative): 
The touchprobe calibration computes the position of the probe relative to the tip of the arm while the 
probe is directly mounted on the sensor in order to allow probing and scanning of the part without 
unmounting the optical sensor to switch from one to the other. 
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4 THE “POSITIONING” PROCEDURE 
The positioning computes the orientation of the sensor on the arm. 
� Attach the datum sphere to the workbench. 
� Select menu “Services > Positioning” to open the Positioning window. 

4.1.1 DESCRIPTION OF THE POSITIONING WINDOW 

 

 
 
 
Acquisition commands 
 
 
 
 
 
Sphere orientation (helps to 
clean the scan automatically, 
when known ; otherwise, 
select “Unknown”) 
 
Real diameter of the datum 
sphere (must be entered 
before computation) 
 
3D scanned data view 
 
Information 

 

Buttons Remarks 

 
These three buttons allow to stop / start / pause the data acquisition. 

 Deletes the displayed scan to allow starting a new acquisition. 

 Reloads the last scanned or recorded acquisition. 

 Computes the “Positioning” from the scan visible in the 3D view. 

 Displays a reminder of positioning procedure. 

 
The buttons on the handle of the arm may also be used to start and pause the data acquisition. 

4.2 DATA ACQUISITION FOR POSITIONING 
   For optimum results, use the provided datum sphere. 

   The positioning window must be open. 

   The Video Settings windows may help to ensure that the acquisition is performed inside the field of 
view of the sensor. 

If the last scanned sphere is visible in the 3D view, then press the “Delete scan” button. Otherwise, 
you may start the data acquisition directly. 
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� Scan the sphere from six different orientations: 
• Above the sphere (green) and in the same direction but rotating 

the sensor by 90° (orange) 
• And from the four other orientations spaced by about 90° 

around the sphere (blue, red, yellow, purple) 
 
It is recommended to avoid as much as possible scanning the support of 
the sphere in order to facilitate the automatic cleaning algorithm (detection 
of the useful laser lines) of the computation. 

 
For each orientation: 
� Press any button of the arm to start scanning; 
� Scan several laser lines (at least twenty) from the sphere while varying the distance of the 

sensor to the sphere to cover the whole range of the sensor’s field of view. 
� Press any button of the arm to pause the acquisition and proceed to the next orientation. 

 
When the 6 orientations are done, press the Stop button in the Positioning window then press the 
Compute button. 

4.3 COMPUTATION OF THE POSITIONING 

4.3.1 LAUNCHING THE COMPUTATION 

   The datum sphere must have been scanned and its real diameter must have been entered. 

� Select the closest direction (axis X, Y or Z and orientation + or -) to the one of the datum 
sphere (the small red arrow on the icon) in the drop-down list. If the direction is hard to tell, 
then select “Unknown”. This information will facilitate the automatic cleaning in order to ignore 
the scanned points that do not belong to the sphere during the computation. 

� Press the “Compute” button. 

4.3.2 ANALYSIS OF THE RESULTS 

The computation displays the XYZ coordinates of the scanned sphere in the coordinate system of the 
arm, as well as its diameter and the difference (between parenthesis) compared to the real diameter. 
That criterium gives a first hint on the quality of the Positioning; however the main criteria is the 
standard deviation computed on the points that remain after the automatic removal of the sphere 
support. 
 
If the computation fails, it is possible to manually delete some points that do not belong to the sphere 
(mouse selection combined with the “Shift” and/or “Ctrl” keys, and deletion with the “Del” key, as in 
Polygonia; see chapter 7) then run the computation again. If it still fails, then the Positioning procedure 
should be performed again and more carefully. 
 
It may happen that the computation succeeds even though the automatic cleaning did not work 
perfectly. The unwanted remaining laser lines will increase the standard deviation. It is then 
recommended to manually delete the few unwanted laser lines and run the computation again. 

4.4 SAVING THE RESULT OF THE POSITIONING 
Saving the Positioning validates the result and the next scanning sessions will use it, even after 
closing the program, until a new Positioning is saved. 

   The datum sphere must have been scanned and a successful computation must have been 
performed. 

� Press the “Save” button then close the Positioning window. 
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5 SCANNING IN POLYGONIA 
Polygonia provides the necessary tools to measure the surface of objects in 3D, which is the main 
function of the Kreon® systems. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The complete digitization of an object is usually done in several passes. It may be necessary to move 
the object (or the arm) to scan it entirely. Reference geometric elements, such as planes or sphere 
can be used to define precise benchmarks used for alignment. 
All these digitizations are gathered in the “Digitization” branch of the hierarchical view of the project. 
Each digitization has a name and corresponds to two files: 

- The first file has a .CWK extension: it is the public file format of Polygonia. It contains the 
processed data of the digitization and it can be imported in most third-party programs that can 
process point clouds. 

- The second file has a .RWK extension: it is a “proprietary format” that contains all the raw data 
of the digitization. It may be used to reconstruct the CWK file in case of accidental data loss. 

5.1 ADDING A DIGITIZATION 
   A project must have been defined/open before adding any digitization. If not already done, save 

the project now. On the creation of the first digitization in a new project that has not yet been saved, a 
dialog box opens automatically to first save the project, before opeing the dialog box that will let you 
add a new digitization. 

� Right-click on the “Digitization” item in the hierarchical view. 
� Select “Add a digitization to project” in the pop-up menu. 

Example of digitization of a 
model (below) and zoomed-
in view of a part of the point 
cloud (opposite image). 
 
 



  

KREON Technologies | User’s Manual SOLANO - 15 - 

 

� To create a new digitization file, enter its name, 
which will be used to create the corresponding 
files. By default, the name “Scan” followed by a 
number will be attributed. 

� To open an existing digitization, press the “…” 
button to browse the files. 

� Enter a comment (facultative) to provide 
information on the new digitization. 

� Press “OK” to validate the addition or creation of 
the digitization. 

 
According to the shape and dimensions of the object, it may be necessary to perform several 
acquisitions, therefore to create successively several digitization files. 

5.2 DIGITIZATION 
   The sensor positioning must have been performed (see chapter 4). 

� Right-click on the name of the digitization that has been added (see section 5.1). 
� Select “Run digitization » in the pop-up menu. 

 

 

� In the Digitization window, set the minimum pitch 
between two laser lines. 

� Optionally set the decimation of the acquired points. 
� The “Optimized frequency” box should remain checked 

by default. 
� The “Visual response” allows to configure the density of 

the displayed laser lines during acquisition. It does not 
concern the number of line actually digitized. Its utility is 
to speed up the acquisition for slower computers by 
reducing the load on the resources used for display. 

 
The “Pitch” defines the distance between two acquired lines and the value of “Keep 1 point out of” 
reduces the number of points on each line. 
 
In the case of particularly shiny or translucent surfaces, it may be necessary to prepare the surface 
(e.g. with white powder) to prevent reflections and help configuring the video settings of the sensor. 
 
� When the surface is ready for digitization, simply proceed as for positioning by using the arm 

buttons (or the onew in the window) to start, pause or finish the acquisition. 
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6 HARD-PROBING IN POLYGONIA 
Touch-probes allow to measure some particular points (or other geometric features) on the part. They 
are often used to take references. 

6.1 ADDING A TOUCH-PROBE 
� Select menu “Setup > Touch-probes management” to access the list of touch-probes. 
� In the opened dialog, press the “Add” button to define a new touch-probe. 

 

 

� Give it a name. 
� Enter the diameter of the ball at the tip of the 

touch-probe. 
� Leave the “Trigger” box unchecked. 
� Press “OK” to validate and return to the list. 

6.2 TOUCH-PROBE CALIBRATION 

 

   At least one touch-probe must have been added to 
select and calibrate it. 
 
 
� Select menu “Services > Touch-probe 

calibration” to open the touch-probe calibration 
dialog; 

� Select the desired touch-probe in the “Probe” 
list; 

� Two touch-probes calibration methods are 
available (see next sections). 

6.2.1 TOUCH-PROBE CALIBRATION BY SPHERE 

� Enter the real diameter of the datum sphere in section “By sphere”; 
� Press the “Start” button in section “By sphere”; 

� Probe at least 9 points as shown in the opposite 
illustrations (side view and top view) by orienting as 
good as possible the touch-probe towards the center 
of the sphere. If you probe more than 9 points, try to 
uniformize their dispersion. 

 
� Press “Stop” to finish the touch-probe calibration; 
� Press “Save” to validate the calibration. 

6.2.2 TOUCH-PROBE CALIBRATION BY HOLE 

� Press the “Start” button in section “By hole”; 
� Place the touch-probe vertically at the bottom of the hole; 
� While keeping the touch-probe at the bottom of the hole, move the 

arm to make three 90° arcs downwards, spaced by 120 ° while 
pressing arm button 1(green) to collect points; 

� Press “Stop” to finish the touch-probe calibration; 
� Press “Save” to validate the calibration. 
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6.3 MEASUREMENTS WITH A TOUCH-PROBE 
   A touch-probe must be mounted on the scanner the touch-probe calibration must have been done. 

6.3.1 HARD-PROBING GEOMETRIC ITEMS 

� Right-click on “Geometric items” in the the hierarchical view. 
� Choose one of the “Probe: xxx” options where “xxx” is the kind of item you want to probe. 

 

 

� Select the touch-probe to use in the list. 
� Follow the instructions that appear in the 

“Message” area depending on the gemetric 
items to probe. 

 
- Short pressure on button 1 (green) ⇒ Aquire 1 point. 
- Long pressure on button 1 ⇒ Delete last point. 
- Long pressure on button 2 (yellow) ⇒ Next step (e.g.: 
compensation of the ball radius of the probe) 
 
� Press “Close” to finish. 

 

When probing points: the obtained points are not compensated by the ball radius of the touch-probe. 
This measure mode should be reserved to point-probes. 

When probing a circle: the compensation point must be probed inside the circle if it is a hole or outside 
for a cylinder. In both cases, the compensation point must be probed above the projection plane 
because it will be used to compensate the plane, too. 

6.3.2 “3/2/1” ALIGNMENT 

“3/2/1 alignment” is a standard method that allows to create a reference change in order to scan in a 
known coordinate system. 
 
� Right-click on “Reference changes” in the hierarchical view. 
� Select “3/2/1 Alignment” to open the following dialog. 

 

 

� Give a name to the alignment; 
� Select the probe to use in the list; 
� Select the axis for each elements (plane, 

line, point). 
� Probe the plane, then the line, and at last the 

point by followinf the instructions in the 
message area (as in the previous section: 
“Hard-probing geometric items”) 

� Invert normals of these elements if 
necessary. 

� Press “OK” to validate. 
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7 POLYGONIA’S 3D VIEW HANDLING 

7.1 MAIN AREAS OF THE INTERFACE 
• Menu bar: it gives access to the main functions of Polygonia: Files, services related to the data 

acquisition and their processing, configuration, etc. 
• Hierarchical view of the project: it represents the list of the data in the project. It always contains 6 

categories : Digitizations, Geometric items, Reference changes, Grilds, Facets, Sections. 
• 3D view: The 3D graphical environment may contain point clouds, geometric items, grids, facets 

(or meshes), sections, etc. 
• Status bar: located at the bottom of the main application window, it provides information (metric 

and quantitative) about the elements of the scene. 

7.2 HANDLING THE 3D VIEW 

 

� Rotation of the view: Move the mouse by keeping the right mouse button pressed. 
The rotation is more precise when pressing the “Ctrl” key at the same time. 

A specific rotation axis (in white) can be defined by pressing the space bar once or more. 
 

 
� Translation of the view: Move the mouse by either keeping the middle mouse button 

pressed, or both the right and left mouse buttons. 
 

 

 

� Zoom in/out: Push/Pull the mouse by keeping the “Shift �” and the right mouse 
button pressed. One can also use the mouse wheel forward/backward to zoom in/out. 

Double-click or press “F4” to recenter the view on the whole scene. 

7.3 POINT CLOUD SELECTION 
 
Polygonia allows the selection of data in the scene either by selecting an area or pointing an item. All 
the selection operations can be cumulated by keeping the “Ctrl” key pressed. To clear the selection 
press “Shift �” and click in an empty area of the 3D view. 

7.3.1 SELECTION BY AREA 

Polygonia allows to select all the items inside  or outside  the defined area. The “Shift �” key 
must always be pressed during the selection. 

• Rectangular selection tool : 
� Press the left mouse button then move the mouse from one corner of the rectagular area to 

the opposite corner then release the mouse button to finish. 

• Free selection tool (lasso) : 
� Press the left mouse button then move the mouse to draw the outline of the area or simply 

click the left mouse button to define the vertices of a polygonal selection. 
� Finish the selection (drawn shape or polygon) by either right-clicking or double-left-clicking. 

7.3.2 SELECTION BY ITEM 

The “Shift �” key must be pressed when selecting an item. 
 
� Click on any point of a laser line to select the whole line. The Left and Right arrowed keys 

(while pressing “Shift �”) allow the selection of the previous/next neighboring line. 
� Double-click on a point select it. The Down and Up arrowed keys (while pressing “Shift �”) 

allow the selection of the previous/next neighboring point. 
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8 OPTIONS COMMON TO ALL ITEMS 
   A context menu (right click) for the items of the hierarchical view (digitizations, geometric items, 

grids, facets and sections) offers the following operations: 

• Hide/Show: 
Allows to hide/show items of the project without actually removing them from the projet when they are 
hidden. 
 
• Delete: 
Irreversibly removes the chosen data from the project. Digitizations are moved to the “Backup” 
directory in case they would have been deleted by mistake. The only way to cancel a deletion of items 
of the other types is to exit without saving the project. 
 
• Color: 
It is possible to changer the color of some items differentiate them better. 
 
• Duplicate: 
Creates an identical copy of an item. For digitizations, the associated fichier is also created in the 
directory of the project with the name: “Copy of...”. 
 
• Select: 
Selects an item or all the points of a digitization. 



  

- 20 - KREON Technologies | User’s Manual SOLANO 

9 FILE IMPORT/EXPORT 
The various items handled by Polygonia can be exported to different file formats in order to be used by 
third-party programs. 

9.1  FILE EXPORT 
� Open menu “File > Export”; 
� Select the destination path and give a name to the file to export; 
� Choose to export the selected items or all the visible items. 
� Press “Save”. 

 
Depending on the chosen export file format, some exportable items (points, grids, facets, sections) will 
be included or not (see the list supported formats below). 
 

Formats IGS VDA DXF STL WRL CBK CWK GRK* ASC TXT BMP M 
Points � � �   � �  � � �  

Grids        �   � � 

Facets   � � �      �  

Sections � � �   � � � � � �  
 
* GRK export only concerns the grids and sections that have been linearly resampled. 
The sections are exported as points fo all formats but GRK. 
The grids can be converted into points by drag’n’dropping the grid icon to “Digitization” in the 
hierarchical view. 

9.2  FILE IMPORT 
� Select menu “File > Import”. 
� Select the file to import. 
� Press “Open”. 

 
Polygonia supports the following formats for import: 
 

Formats CBK 
(Binary or ASCII) GRK* ASC 

(ASC: X Y Z) 
TXT 

(ASCII: L X Y Z) 
Points � � � � 

Grids  �   

Facets     

Sections     

* GRK files can be imported as digitizations or grids. 
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